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1. Introducing Vba32 Control Center

Vba32 Control Center with web-interface is a product of VirusBlokAda Ltd. which allows 
establishing  centralized  management  and  gathering  statistics  of  the  Vba32  antivirus 
functioning at network workstations.

The product is the basic means to arrange a corporate antivirus protection system for 
medium  and  small  business  as  well  as  for  large  companies  with  geographically 
distributed departments.

Vba32 Control Center is a client-server application consisting of a management part, a 
database,  a  web-interface  (should  be  installed  at  antivirus  protection  server),  and a 
client part – Remote administration agent that is included into the Vba32 antivirus. 

Vba32 Control Center functionality provides the following:

 managing the  Vba32  antivirus  at  workstations  including  configuring  and  selective 
enabling/disabling antivirus components;

 gathering of information on the Vba32 antivirus key events occurred at workstations 
including  detection  of  malware  as  well  as  performing  any  actions  on  them; 
enabling/disabling antivirus components; update status, etc;

 launching antivirus scanning of a workstation by Vba32 Scanner;

 permanent monitoring  as  well  as  reporting  of  the  Vba32  components  state  at 
workstations;

 retrieving information on the latest successful update, latest virus detection, version 
of the Vba32 antivirus installed at a workstation;

 viewing statistics  of centralized antivirus  protection system in the form of reports, 
tables, charts and diagrams;

 retrieving additional  information  on  a  workstation  such  as  CPU  frequency,  RAM 
capacity, logged in user name;

 retrieving list of processes supplied with full paths to the executables;

 launching the command line at a workstation;

 establishing hierarchical system of the Vba32 Control Centers;

 notifying specialists  responsible  for  computer  protection  of  the  events  by  e-mail, 
jabber and network messages.

Vba32 Control Center features are the following:

 web-interface  allows  managing  Vba32  Control  Center  from  any  computer  in  the 
network;

 no software  should  be  installed  at  operator’s  workstation –  only  a  web-browser  is 
needed (the program supports the most popular versions);

 flexible interface allows using “templates” as well as “themes”, changing languages;

 possibility to create user’s own color scheme for displaying events, own table filters, 
own tasks;

 individual configuration of the web-interface for every user;

 export of the event tables to Microsoft Excel;

 import / export of user settings to XML-file.



2. Usage Requirements

2.1 Hardware Requirements

Vba32 Control Center is a server application consisting of several services. The components 
of Vba32 Control Center are supposed to be active round-the-clock. This will provide the 
most relevant information and first response in case of network threat. So it’s recommended 
to install Vba32 Control Center at a computer that operates round-the-clock.  

The minimum hardware requirements are the following:

 CPU: Pentium III 1000 MHz;

 1 GB RAM;

 200 MB of hard disk free space for the program and up to 1.5 GB – for databases;

 100 Mbit network card.

2.2 Software Requirements

The following software should be installed at the computer where Vba32 Control Center is 
used:

 Operating system (OS): Windows XP Professional SP2 or greater, Windows Server 2003 
SP1 or greater, Windows Server 2008 SP1 or greater, 32- and 64-bit (for the server ones 
only) versions of OS;

 Database management system (DBMS): Microsoft SQL Server 2000 SP4 or greater, MSDE 
2000a;

 Web-server: Internet Information Services (IIS) 5, IIS 6, IIS 7;

 Microsoft .NET Framework 2.0 (for Windows XP and Windows Server 2003).

The following web-browsers are recommended to work with the Vba32 Control Center web-
interface:

 Microsoft Internet Explorer 6, 7, 8 (IE7 or greater is recommended);

 Mozilla Firefox 3.

Correct functioning of all components when using other web-browsers isn’t guaranteed.

2.3 Qualification Requirements

A specialist, who will operate Vba32 Control Center, should posses the following knowledge 
and skills:

 Basic knowledge of the Windows NT operating system functioning;

 Skills to work with the Window services, system log and NTFS file system;

 Basic knowledge of the network communication and TCP/IP protocol stack;

 Basic knowledge of the e-mail functioning;

 Basic knowledge of the Internet Information Services administration;

 Knowledge of the Microsoft SQL Server administration;

 Skills to work with the Vba32 antivirus.



3. Managing Vba32 Control Center

Two fundamentals of the Vba32 Control Center functioning are events and tasks.

Antivirus protected computers are displayed in Vba32 Control  Center as registered.  The 
agents installed at the registered computers send messages about key events occurred at 
workstations such as  enabling/disabling antivirus protection, updating, detecting malware, 
etc.  All  messages  are  saved  in  the  common  event  list;  it’s  possible  to  configure 
administrator notifications when some kind of event is occurred.  

If some actions regarding managing antivirus protection should be performed – for example, 
it’s  needed  to  configure  Vba32  antivirus  components,  turn  on/off  them,  start  antivirus 
scanning – a computer can be assigned a task with further monitoring of its execution. 

Vba32  Control  Center  provides  with  numerous  additional  features:  retrieving  detailed 
information on a workstation as well as on its antivirus protection state.

Event message response takes a minute at the most after it has been occurred. Efficiency of 
getting information on changing state of the key Vba32 components is a minute at the most. 

3.1 Getting Started

The main control unit of Vba32 Control Center is the web-interface. To invoke it, run your 
web-browser and print the following in the address line:

http://server/Vba32CCWebConsole/

You should replace server with real computer name where the server part of Vba32 Control 
Center is installed.

The authentication page will  be loaded.  User login and password should be specified to 
access the web-interface.

During  the  Vba32  Control  Center  installation  the  user  with  the  following  credentials  is 
created:

Login: admin

Password: 1234qwer!

You can use the credentials to access Vba32 Control Center first time. After successful login 
the main page of the web-interface is displayed.



The main page contains the information on the current web-interface user, database and 
state of the Vba32 Control Center services.

Note: After successful opening of the page it’s recommended to bookmark its address in your 
web-browser.

It’s strongly recommended to change immediately the password of the admin account (see 
“Changing Private Information and Password”) as well as create new users (see “Creating 
User”) to work with the Vba32 Control Center web-interface.

3.2 Working with Lists

Your can explore through five lists provided by Vba32 Control Center: Computers, Events, 
Tasks, Components and Processes. To start working with any of the lists, you should press 
the corresponding link in the “List” menu item.

The lists are displayed in the form of tables. Basic principles of operation with them are the 
same.

There is a filter panel above the tables. Its default state is minimized. To maximize it, you 
should  press  the  arrow  in  the  right  top  part  of  the  panel.  The  panel  contains  filter 
configuration fields (type and number of the fields vary for different lists). Press the arrow 
once again to minimize the panel.



There  is  an  additional  control  panel  below the  filter  panel.  It  allows  resizing  the  page, 
managing automatic update and the filter panel state (see “Working with Tables” to learn 
more).

The “Design” drop-down list specifies the filter panel state. Detailed description of how to 
use it is given below (see “Managing Filter Panel”).

There is a task panel at the bottom of the table for the “Computers” list. The panel contains 
fields to specify parameters of a task to be assigned (see “Assigning Tasks” to learn more).

Note: Task panel is hidden when working with Vba32 Control Center in the observation mode.

The task panel is minimized as well as maximized by pressing the arrow in the right top 
corner.

Working with Tables

Data selected by the corresponding filter are displayed as a table with paging. 

Select the number of pages (available values are 1, 10, 25, 50, 100) to be displayed per 
page with the help of the “Page size” drop-down list at the additional control panel. The 
changes will be applied immediately.

Use a special control consisting of 4 links, information on the current page and total page 
count (Page X of XX) to browse through the pages. Page browsing is standard: links > and < 
load the next and the previous page correspondingly, << and >> - the first and the last 
one.

Information on the count of records that match the selected filter is displayed in the top 
corner of the table.



The “Enable automatic update of content” flag enables asynchronous content refresh on the 
“Events” and “Tasks” pages (see “Configuring Automatic Asynchronous Content Refresh” to 
learn more). 

The tables can be sorted ascendingly as well as descendingly. To do so, press the name in 
the table header; ascending sort will be performed when pressing the first time, the second 
pressing will cause descending sort. 

Filtering

Search, for example, search for a report by the specified computer, events occurred within 
the specified period of time, etc, is a main operation that is performed when exploring a list. 
This functionality is implemented in Vba32 Control Center by flexible filters which can be 
saved for further usage.

Information from every list can be filtered by any fields. There are several filter containers 
because the fields can contain data of various types:     

 Edit boxes. The type of a container is described below;

 Drop-down lists. The type allows selecting a value from a preformed list of values;

 Flags.  The type allows setting a boolean value (true or false) which corresponds to the 
flag state – checked or unchecked;

 Date. Containers of this type are special controls that allow configuring a time interval 
(by drop-down lists). The “From” value should be earlier than “To”.



It is supposed that a user prints some text information in the edit boxes. There can be string 
or numerical containers depending on the data type used in the corresponding table field.

Russian as well as English symbols, digits and punctuation characters can be specified in the 
string container. Wildcards can be used in these containers as well: «_» (underscore without 
quotes  –  any  symbol)  and «*» (asterisk without  quotes  –  any  number  of  any symbols). 
Moreover it is possible to specify a composite value of the container. The values should be 
separated by the & symbol in this case:

Arg1[&Arg2]…[&ArgN], where Arg1, Arg2, … are valid parameters values.

The numerical  containers  allow specifying a range of  valid  parameter  values.  The input 
format is the following:

Arg1-Arg2, where Arg1, Arg2 are unsigned integers and Arg1 should be less than Arg2.

Set the flag opposite the container name to indicate that it is used in the filter. Otherwise 
data specified in the container won’t be added to the filter.

Boolean relation between some parameters can be specified when using several containers 
simultaneously. To do so, one of the following values can be selected from a drop-down list 
on the left of the container:

 AND – specified criteria must be in the final selection;

 OR – specified criteria may be in the final selection. It is used for several containers;

 NOT – specified criteria must not be in the final selection.

Managing Filter Panel

Containers of a filter are located at the filter panel. Containers are divided into groups (e.g. 
“Main” and “Additional” for events) that can be minimized, maximized, closed or moved. It 
increases flexibility when working with the filters. The corresponding links at the group panel 
minimize, maximize and close the group. Pressing the “Close” link will removed completely 
the selected group from the initial page.

There are three modes of displaying filters: view (to work), design (to change the position of 
container  groups)  and  catalog  (to  add  hidden  groups).  To  switch  the  modes,  use  the 
“Design” drop-down list that is located at the additional control panel.

“View” mode is a main mode to work with the filter panel. It  allows specify data in the 
containers apply and save filters, clear them, etc. Position and order of the container groups 
remain fixed.

“Design” mode allows changing container group position at the page. To do so, drag the 
groups by mouse (provided it is supported by your web-browser) to the signed areas of the 
filter panel.

“Catalog” mode allows adding container groups hidden by the “Close” link. To do so, select 
a group by checking the flag opposite it, select the name of a zone from a drop-down list 
and press “Add”.



Operating Filters

Note: Some operations over filters can be performed only when the filter panel is maximized. 
Press the arrow in the right top part of the filter panel for this. 

Applying

To apply a filter saved earlier, you should select it from the “Filter” drop-down list at the 
filter panel.

To configure and apply a temporary filter (see “Temporary Filter” to learn more), you should 
complete all  the containers needed, enable them by checking the flags on the right and 
press the “Apply” link at  the filter panel.  Provided all  information is valid,  the table will 
display the results. 

Warning!  It  may  take  some  time  to  retrieve  the  results  from  a  server  if  the  database  has 
considerable size. It’s recommended not to use the asynchronous refresh in this case because this 
entails additional server load

Saving

A filter configures by a user can be saved for reuse. To do so, press the “Create” link at the 
filter panel to load a special page. At that all specified values in the containers to be used in 
the filter will remain unchanged in the corresponding fields.

Specify a unique filter name in the edit box at the page bottom and press the “Save” link to 
save the filter. An error message will be displayed if  such name already exists in the filter 
collection. 

Warning! You shouldn’t use names of librarian temporary filters as a name of a user filter in any of 
available languages of the web-interface.

Editing

Select a filter from the “Filter” drop-down list and press the “Edit” link at the filter panel to 
edit the filter. Then you will be redirected to the filter creation page.



After all modifications needed are performed press the “Save” link.

Note: If the specified filter name differs from the initial one a new filter will be created.

Deleting

Select a filter from the “Filter” drop-down list, press the “Delete” link at the filter panel and 
confirm the deletion by choosing “OK” to delete the filter.

Clearing

If some filter has been applied to a list and it’s needed to retrieve the initial list you should 
clear the filter. Press the “Clear” link at the filter panel to do so. All containers will be cleared 
(except date controls) and all flags will be unchecked. The “Temporary filter” value will be 
specified as the selected filter and a table will contain the initial list

Temporary Filter

Any unsaved user filter is called a temporary filter. It’s specified in the “Filter” drop-down list 
by default. Initially it’s empty, so no filtration is performed. All changes made by a user will 
be lost when Vba32 Control Center session is ended.

It’s useful to apply a temporary filter to retrieve a selection that is unlikely to be reused. It’s 
recommended to create and save a user filter otherwise.

Exporting Data to Excel

Data retrieved by a filter and displayed at the list page can be exported to a Microsoft Excel 
document  (workbook).  To  do  so,  press  the  “Excel”  link  in  right  corner  under  the  table. 
Standard save file dialog box will be invoked. All data that match the current filter will be 
exported to the Excel  document  (regardless of  the page size settings and current  page 
number).

Example:

The following steps should be made to export all events from the specified workstation to Excel.

1. Specify the name of the workstation to the “Computer” container at the event list page and 
check the corresponding flag on the right of the edit box. It will show to the system that the 
container is used in the filter;

2. Press the “Apply” link at the filter panel;

3. Press the “Excel” link when the event list is displayed;

4. Specify the path and name of saving file in the invoked dialog box and press the “Save” button.



Retrieving Statistical Report

Statistical information on antivirus protection functioning can be displayed by Vba32 Control 
Center in the form of statistical tables or diagrams.

Select the “Statistics” link in the “Statistics” menu to view the statistical tables. A page, 
where the information on the total number of registered workstations, events, tasks as well 
as on antivirus protection system functioning for today is displayed as a text.

Press the “Diagrams” link in the “Statistics” menu to view the diagrams. Depending on the 
user’s choice the statistics can be displayed as histograms, diagrams or tables at this page.

The diagram type can be switched by the “Appearance” drop-down list.  Moreover some 
basic types of statistical information are available:

 Number of events;

 Number of events for today;

 Number of viruses;

 Number of viruses for today;

 Total virus prevalence;

 Virus prevalence per month;

 Virus prevalence for today.

Selecting  one  of  the  types  will  display  the  corresponding  information  as  diagrams, 
histograms or tables with “workstation name - number” pairs for the first ten records sorted 
descendingly.

In addition, own statistical criterion can be specified for events. To do so, configure a filter at 
the “Events” page and press the “Diagrams” link at the bottom of the table near the “Excel” 
link. You will be redirected to the “Diagrams” page; however the “Type” drop-down list will 



be hidden but the current filter name (or nothing if the filter is temporary) will be displayed 
instead. 

Example:

Display statistics on viruses founded within specified time interval.

1. At the page containing event list print the name of the virus detection event 
(vba32.virus.found) to the “Event” container and check the corresponding flag on the right of the 
edit box. It will indicate that the container is used in the filter;

2. Configure the “Date” container. It should contain the start and end of the time interval to be 
used;

3. Press the “Apply” button at the filter panel;

4. Press the “Diagrams” link after the event list is displayed.

3.3 Assigning Tasks

Task is specified program actions performed by the client part of Vba32 Control Center at a 
local  computer  by  the  management  part  command.  Tasks  are  assigned  by  the  Vba32 
Control Center web-interface.

Warning!  Working  with  tasks  (assignment,  saving)  are  unavailable  when  using  Vba32 Control 
Center under the observer account.

There are basic and user tasks. Basic tasks are the tasks that implemented in Vba32 Control 
Center by its developers.  These tasks are the basis of  task mechanism functioning.  The 
following tasks are the basic ones:

 Create process;

 Send file;

 Launch scanner;

 Get system information;

 Get list of processes;

 Get components state;

 Configure Vba32 Loader;

 Configure Vba32 Monitor;

 Configure Vba32 Quarantine;

 Set password.

User tasks are created on basis of the basic ones by specifying all or a part of parameters. 
Then a user task should be saved in the database with the specified name. After that the 
task can be assigned by selecting it from the task list.

How to Assign Tasks

Use the “Computers” page to assign task.

First of all check computers in the table that tasks should be assigned to.  A task can be 
assigned to a computer, a group of computers or all computers simultaneously. To select all 
computers displayed at the current page, you can use the “+” button located in the table 
header. Check the “Assign the task to all computers that match current filter” flag to assign 
a task to all computers that match current filter (regardless whether they are displayed at 
the page or not).



Next you should select the task from the “Task name” drop-down list, specify, if needed, its 
execution options (to do so, it may be necessary to maximize the task panel by using the 
arrow on the right) and press the “Assign task” link. 

Provided the assignment  has been made successfully, the corresponding message will be 
displayed  above  the  task  panel.  Afterwards  a  record  about  assigned  task  with  the 
“Assigned” status for each workstation will be displayed in the task list on the “Tasks” page.

Basic tasks

Create process

The task is designed for creating a process on a client workstation with specifying command 
line options.

The “Command line” edit box should contain a full path to the process to be launched and, if 
needed, command line options.

Provided the “Run via command line” flag is checked, you can use such commands as copy, 
md, etc.

Warning!  Maximum  number  of  simultaneously  executing  “Create  process”  tasks  at  any 
workstation is 10. If you try to run the eleventh task it will  be marked by the “Execution error” 
status.

Send file

The task is designed for sending a file to a client workstation.

First of all you should upload the file to a server. To do so, press the “Browse” button in the 
standard dialog box, select the file to be sent and press the “Upload” link.

Warning! The size of the file to be uploaded shouldn’t exceed 2.097.151 Kb.

After uploading the “Information” label will contain the information on the file.

The “Source file” edit box will be completed automatically with the path that can be used by 
Aghent for downloading the file. All files are uploaded to the “Downloads” subfolder of the 
web-console with. They posses unique name and have no extensions.



You should specify the destination in the “Destination file” edit box where Agent should save 
the file to after downloading. This edit box can contain environment variables (%WINDIR%, 
%VBA32%, etc) that will be expanded at the client computer.

Note: If the edit box is empty until the “Upload” link is pressed it will be automatically completed 
with the “%VBA32%source_file_name” string.

Launch scanner

The task launches the scanner with parameters set by a user. You can specify settings that 
correspond to the Vba32 Console Scanner settings at the “Objects”, “Actions”, “Report” and 
“Additional” tabs. 

Vba32 Console Scanner is launched in the hidden mode at a client computer with this task 
has been assigned.

Get system information

The task  orders Agent to send immediately information on the system as well as on the 
antivirus integrity and key file relevance at the client computer.

The task has no parameters.

Get list of processesв

The task  orders Agent  to send immediately the list  of  processes launched at  the client 
computer.

The task has no parameters.

Get components state

The task orders Agent to send immediately the state of antivirus components.

The task has no parameters.

Configure Vba32 Loader

The task allows configuring Vba32 Loader. You can specify settings that correspond to the 
Vba32 Loader settings at the “Initialization”, “Report file” and “Update” tabs.



Configure Vba32 Monitor

The task allows configuring Vba32 Monitor. You can specify settings that correspond to the 
Vba32 Monitor settings at the “Objects”, “Background scanning”,  “Actions” and “Report” 
tabs.

Configure Vba32 Quarantine

The task allows configuring Vba32 Quarantine. You can specify settings that correspond to 
the Vba32 Quarantine settings at the “General” and “Maintenance” tabs.

Set password

The task allows setting a password for accessing (modifying its settings and modes) Vba32 
Loader (similarly to press the “Password” button at the “General” Vba32 Loader tab). You 
should specify a new password in the “New password” edit box.

Creating User Task



To create user tasks,  you should select the needed type of a basic task from the “Task 
name” drop-down list and press the “Save” button on the right of the list. Afterwards the 
“Create task” page will  be loaded. There you should specify task parameters,  its unique 
name (provided the task hasn’t been created on the basis of the task saved earlier) in the 
“Task name” edit box and press “Save”.

Warning!  You shouldn’t save tasks without parameters as well as give user tasks names of any 
basic tasks (in any supported languages).

Deleting user task

To delete a user task, select it from the “Task name” drop-down list, press the “Delete” link 
on the right of the list ans confirm the operation.



4. Configuring Vba32 Control Center

4.1 Managing Users

A user  should  be  authorized  to  view any page of  Vba32 Control  Center.  To access the 
system, you should create an account. Vba32 Control Center can support 128 user accounts. 
The number of users that can work with Vba32 Control Center simultaneously is limited by 
the hardware of antivirus protection server.

Creating User

Warning! Creation, editing and deletion of a user can be performed only when working under an 
account with administrative privileges.

Press the “Registration” link in the “Administration” menu to create a user. A registration 
form will be loaded.

The following fields should be completed:

 Login – name of the account;

 Password – an account password, no less 7 characters length and, should be specified 
there; it should contain at least one special character (neither a letter nor a digit);

 Confirm password – retype the password to avoid error;

 Name, Surname, Email – user’s data.

A user role can be selected at the bottom of the form. There are three roles:

 Observer – allows viewing lists of computers, events and processes as well as statistics;

 Operator – additionally allows assigning tasks on the “Computers” page and monitoring 
their state with the possibility to cancel them on the “Tasks” page. The corresponding 
panel at the bottom of the computer list becomes visible for assigning tasks;

 Administrator – allows, besides all operator’s features, changing settings of the database 
maintenance  (the  “Maintenance”  page)  and  notifications  (the  “Notifications”  page). 
Moreover an administrator can create users and manage them (the “Registration” and 
“Users” pages) as well as change global coloring of the events for the “Events” page.

After the user creation form has been completed press the “Create” link. If everything is 
correct  the  “New  account  successfully  created”  label  will  be  displayed.  Otherwise  all 
incomplete fields will be marked by a red asterix.

Changing User Role



Warning! Creation, editing and deletion of a user can be performed only when working under an 
account with administrative privileges.

Press the “Users” link in the “Administration” menu to display a list of users that is used for 
changing user role. Press a link that indicates user’s current role in the list opposite the 
account which role is to be changed. 

A drop-down list will be invoked. Select a new role from it and press the “Update” link. Use 
the “Cancel” link to undo the action. Results of modifications are displayed immediately in 
the list of users.

See “Creating User” topic to learn more about user roles.

Deleting User

Warning! Creation, editing and deletion of a user can be performed only when working under an 
account with administrative privileges.

Press the “Users” link in the “Administration” menu to display a list of users that is used for 
deleting a user. Press the “Delete” link opposite needed account in the list and confirm the 
operation.

Modifying Private Information and Password

The  web-interface  of  Vba32  Control  Center  allows  users  to  modify  their  own  private 
information and password. To do so, press “Main” link in the “Settings” menu. The settings 
page will be loaded.

To  modify  name  and  surname,  specify  the  corresponding  data  to  the  “Name”  and 
“Surname” fields and press “Save”.



Note: Lagin as well as e-mail can’t be changed after the registration. Instead you should create a 
new user with new login.

To  change  the  password,  complete  the  “Changing  Password”  form  with  the  current 
password (the “Password” field) and a new password (the “Confirm new password” field). 
After the completion press the “Change password” link.

Note: It’s impossible to change private information and password of other user.

4.2 Configuring Appearance

The web-interface of Vba32 Control Center is rather flexible and can be configured for user’s 
need. It supports various appearance templates, color schemes and themes.

Majority of the settings can be applied for the current user only; it will be reported if the 
specified option can affect other users.

Appearance settings are saved and applied when accessing Vba32 Control Center next time.

Configuring Appearance Templates

There are several variants of the appearance and mutual alignment of the controls on the 
Vba32 Control Center pages. One of them is the variant with a navigation menu on the left, 
another one is on top.

Open a page containing settings to choose an appearance template. To do so, press the 
“Main” link in the “Settings” menu.

Appearance template is specified by the “Page template” drop-down list.

After the needed template has been chosen you should press the “Save” link. The settings 
are applied immediately.

Configuring Appearance Theme

Vba32 Control Center supports page appearance themes (color design).

Open a page containing settings to choose an appearance theme. To do so, press the “Main” 
link in the “Settings” menu.

Appearance theme is specified by the “Theme” drop-down list.



After  the  needed  color  theme  has  been  chosen  you  should  press  the  “Save”  link.  The 
settings are applied immediately.

Configuring Events Coloring

Note: This option affects all Vba32 Control Center users.

Vba32 Control Center allows using coloring of different types of the events displayed on the 
“List of events” page.

Color scheme can be configured on the “Event color” form of the “Settings” page. To open 
it, press the “Additional” link in the “Settings” menu.



A list of event types registered in the system is displayed in a form of a multipage table. 
Page  browsing  is  standard:  links  >  and  <  load  the  next  and  the  previous  page 
correspondingly, << and >> - the first and the last one.

To  change  the  color  of  an  event,  press  its  name,  selecting  the  color  needed from the 
invoked drop-down list and press “Update”.

Settings are applied immediately; results can be viewed on the “List of events” page.

Configuring Columns in List of Computers

Vba32 Control Center allows enabling/disabling display of columns in the list of computers.

To select  columns that  will  be displayed in the list  of  computers,  you should  press the 
“Additional” link in the “Settings” menu. All fields needed should be checked.

Press the “Save” link to apply the settings.

Configuring Automatic Asynchronous Content Refresh

When you are viewing the tables by the web-interface, it’s necessary to refresh forcibly a 
page in your web-browser to get relevant data. Vba32 Control Center supports automatic 
refresh of the table content in specified time intervals without need to refresh the entire 
page (technology of asynchronous java-scripts is used).  

Note: The feature is implemented for two most refreshing lists: event list and task list.

To enable asynchronous content refresh, check the “Enable automatic update of content” 
flag on the page containing the corresponding list. The settings are applied immediately and 
saved for the current user.

Press  the  “Additional”  link  in  the  “Settings”  menu  to  configure  refresh  intervals.  The 
intervals should be specified in the “Events” and “Tasks” edit boxes on the “Configuring 
automatic content refresh” form, separately for each list.



Warning! Automatic content refresh entails additional load on the database server as well as on 
your web-browser. It’s not recommended to decrease a refresh interval greatly.

Press the “Save” link to apply the settings.

4.3 Configuring Notifications

Vba32 Control Center allows notifying specialists responsible for computer protection of the 
events. There are three notification types:

 by e-mail;

 by jabber;

 by net send.

First two types require a server that provides the corresponding service.

Note: It’s recommended to use local servers for notifications such as mail and jabber.

Individual notification settings (recipient, text, etc) can be specified for each registered type 
of events.

Warning! This configuration can be made only when working under an account with administrative 
privileges.

Press  the  “Notifications”  link  in  the  “Administration”  menu  to  change  the  notification 
settings.

Selecting Event to Be Notified of

The “Registered events” form contains multipage list of the events registered in the system. 
Page  browsing  is  standard:  links  >  and  <  load  the  next  and  the  previous  page 
correspondingly, << and >> - the first and the last one.

The “Notify” column, on the left of the event name, contains an option in a form of an icon 
whether notifications will be sent when the event has been registered or not. If the icon is 
green notifications will be sent. To change the option, press the icon, and it will become red.

After the “Notify” option has been checked it’s necessary to specify notification type and to 
configure some settings.

To configure notifications individually for each event, press the event name in the list. The 
header of a form on the right of the list will be changed to the event name automatically.



Configuring Notifications by E-mail

A mail server should be specified to send notifications by e-mail. The “Mail settings” form of 
the “Notification service settings” page is designed for this purpose.

The “Mail  server” field should contain the IP-address of  the server that will  be used for 
sending mail. As a rule, a local server of your company should be used.

Type the name of a mailbox that mail will be sent from in the “From” field.

Warning! Some mail servers require specifying real mail box.

The “Display name” field should contain the name that will be displayed in a mail client 
instead of the e-mail address specified in the “From” field

Press the “Save” link to apply the settings.

To configure notification body and recipients, select the event (see “Selecting Event to Be 
Notified of”) and press the “Mail” link on the form located on the right of the event list.

Check the “Use mail” flag to enable mail notification of the event.

To add a recipient of the notification, type his e-mail address to the “Recipients” field and 
press the “Add” link. Specified address will be added to the list. To delete a recipient, you 
should select him in the list and press the “Delete” link.



The  “Subject”  and  “Body”  fields  should  contain  subject  and  body  of  the  notification 
correspondingly. You can use the replacing macros (see “Replacing Macros for Subject and 
Body of Notification” to learn more).

Priority of the notification can be set by a switch on the page bottom.

Press the “Save” link to apply the settings.

Configuring Notifications by Jabber

A jabber server as well as account should be specified to send notifications by jabber. The 
“Jabber  settings”  form  of  the  “Notification  service  settings”  page  is  designed  for  this 
purpose.

You should type the server name to the “Jabber server” field. It will be used for sending 
messages.

Note: You can use external servers such as jabber.ru or jabber.org. But it’s recommended to 
install the local one (e.g. ejabberd).

The  “From”  field  should  contain  JID  (account  identifier)  that  will  be  used  for  sending 
messages. The account must be registered earlier with the help of your server services.

The “Password” field should contain a password of the account specified in the “From” field.

Press the “Save” link to apply the settings.

To configure notification body and recipients, select the event (see “Selecting Event to Be 
Notified of”) and press the “Jabber” link on the form located on the right of the event list.

Check the “Use Jabber” flag to enable jabber notification of the event.

To add a recipient of the notification, type his JID to the “Recipients” field and press the 
“Add” link. Specified JID will be added to the list. To delete a recipient, you should select him 
in the list and press the “Delete” link.

The “Body” field should body of the notification.  You can use the replacing macros (see 
“Replacing Macros for Subject and Body of Notification” to learn more).

Press the “Save” link to apply the settings.

Configuring Notifications by net send

Warning! To send correctly notifications by net send, the “Messenger service” service should be 
launched at the server as well as at recipient’s computer.



To configure notification body and recipients, select the event (see “Selecting Event to Be 
Notified of”) and press the “NetSend” link on the form located on the right of the event list.

To enable notifications by net send for the event, the “Use NetSend” flag should be checked.

To  add  a  recipient  of  the  notification,  type  his  computer  name  or  IP-address  to  the 
“Recipients” field and press the “Add” link. Specified address will be added to the list. To 
delete a recipient, you should select him in the list and press the “Delete” link.

The “Body” field should body of the notification.  You can use the replacing macros (see 
“Replacing Macros for Subject and Body of Notification” to learn more).

Press the “Save” link to apply the settings.

Replacing Macros for Subject and Body of Notification 

You can use replacing macros which values will be substituted on the basis of specific event 
when body and/or subject of a notification are being formed.

The following macros are available:

 {Computer} – the name of the computer where the event has occurred;

 {IPAddress} – the IP-address of the computer where the event has occurred;

 {EventName} – the name of the event;

 {EventTime} – date and time of the event;

 {Component} – a component that has generated the event;

 {Object} – an object involved in the event;

 {Comment} – event commentary.

For example, a virus detection notification may be as follows:

WARNING! Virus {Comment} in {Object} ({Component}) has been detected at 
computer {Computer}

4.4 Configuring Database Maintenance

Vba32 Control Center stores its data in the database. It may become too large with the time 
being and reduce the performance of Vba32 Control Center.  

Warning! You should monitor the size of the Vba32 Control Center database. The greater its size 
the greater  server  hardware requirements.  It’s  strongly recommended to  make backups of the 
database periodically.

The  information  on  obsolete  events  can  be  removed  from  the  database.  A  periodic 
maintenance  service  clears  the  database  of  the  events  automatically.  Moreover  Vba32 



Control Center can be configured not to remove from the database events of the specified 
type (e.g. malware detection events or other critical events).

Warning! This configuration can be made only when working under an account with administrative 
privileges.

Press  the  “Maintenance”  link  in  the  “Administration”  menu  to  configure  the  database 
maintenance.  In the “Delete events older (days)” field on the “Settings” form you should 
specify the number of days on the expiry of which the events will  be removed from the 
database.

Besides of clearing the database of obsolete events the periodic maintenance service also 
switches the status of assigned task to “Execution timeout” if Agent hasn’t replied within a 
minute; of executing task to “Execution timeout” if the task hasn’t been finished within two 
hours.

The same form allows configuring a period of time on expiry of which the service checks the 
database  for  the  need  of  event  clearing  or  updating  task  state.  Use  the  “Maintenance 
interval (seconds)” field for this purpose.

Press the “Save” link to apply the settings.

You  can  specify  the  events  that  will  never  be  removed  from  the  database  on  the 
“Maintenance service settings” page. The “Events to send” form displays a multipage list of 
the events registered in the system. Page browsing is standard: links > and < load the next 
and the previous page correspondingly, << and >> - the first and the last one.

The “Do not delete” column, on the left of the event name, contains an option in a form of 
an icon whether the event will remain in the database regardless of its registration time. If 
the icon is green the event won’t be removed from the database during the maintenance. To 
change the option, press the icon, and it will become red.

The changes will be applied immediately.

4.5 Configuring Self-Update

Vba32 Control Center supports self-update as well as update of its components by standard 
mechanisms of VirusBlokAda.

You should  make  sure  that  the  synchronization  of  VBA32AAW is  enabled  in  the  Vba32 
Update Center settings before you try to perform self-update of Vb32 Control Center from a 
local resource created by Vba32 Update Center.

Warning! This configuration can be made only when working under an account with administrative 
privileges.



Press the “Update” link in the “Administration” menu to modify self-update settings.

Updating from Local Folder

If the update is performed from a local resource you should specify a path to the resource in 
the “Update path” field and uncheck the “Use proxy-server”, “Use authorization” and “Use 
impersonation” fields.

Press the “Save” link to apply the settings.

Updating from Local Network

An update service included in Vba32 Control  Center functions  under  the LOCAL_SYSTEM 
account.  It  can’t  access  the  network,  so  you  should  perform additional  configuration  of 
authorization to update from a network folder.

Provided the computer, where Vba32 Control Center is installed, and the computer that the 
update  is  performed  from,  are  in  the  same  domain,  you  should  check  the  “Use 
impersonation”  flag  and  specify  domain  user  name  as  well  as  his  password  in  the 
corresponding fields of the “Update” form.

Warning! This user should have enough privileges to read the network update folder. As a rule it’s 
enough to specify credentials of your domain user.

Provided the update is performed from a computer that belongs to a workgroup, you should 
check  the  “Use  authorization”  flag  and  specify  user  name  and  his  password  in  the 
corresponding fields of the “Update” form.

Anyway you should specify the path to the network folder in the “Update path” field.

Press the “Save” link to apply the settings.

Updating from ftp/http-server

Provided the update is performed from a ftp or http server via proxy, you should check the 
“Use proxy-server” flag and specify proxy information in the “Server” and “Port” fields of the 
form.  If  the  proxy-server  requests  authorization  check  the  “Use  authorization”  flag  and 
specify user information in the corresponding fields (check the “NTLM-authorization” flag if 
needed).

If the ftp-server requests authorization check the “Use impersonation” flag and specify user 
name and his password in the corresponding fields of the form.

Anyway you should specify the path to the network update folder in the “Update path” field.



Press the “Save” link to apply the settings.

4.6 Exporting and Importing User Settings

Vba32 Control Center allows saving all or a part of user settings (list filters, user tasks) to a 
file.  The feature  can  be  useful,  for  example,  when reinstalling  Vba32 Control  Center  or 
creating a new user with settings that are the same as the existing ones.

Note: Appearance settings can’t be exported.

Exporting Setting to File

Press the “Export/Import” link in the “Settings” menu  to save the settings of the current 
user.  Check  the  settings  that  you  are  going  to  export  (filters  of  computers,  events, 
components, processes, tasks, user tasks) on the invoked form and press the “Export” link. 
Afterwards specify a path that a file will be saved to and press the “Save” button.

Default configuration file name is Vba32CC_settings_login.xml, where login eill be replaced 
with a real account name. 

Note: Configuration file will be saved at a client computer, the computer where the web-interface 
is loaded in the web-browser..

Importing Settings

You should have a file with exported settings obtained on the previous step to import the 
settings.

To import all settings from the file, you should specify the path to the configuration file on 
the “Export/Import” page (or use the standard dialog box by pressing the “Browse” button). 
Then press the “Import” link.

Deleting All User Settings

To delete some of user settings (filters of computers, events, components, processes, tasks, 
user tasks), you should check the corresponding items on the “Export/Import”  page and 
press the “Delete” link. 

4.7 Establishing Multilevel  Hierarchical  System  of  Vba32 
Control Centers

If your company consists of considerable number of geographically distributed departments 
that are connected to the head office by dedicated line it’s reasonable to install separate 
Vba32  Control  Centers  at  these  departments.  In  this  case  an  antivirus  protection 
administrator, who is responsible for entire company, should be notified of the protection 
state at every workstation or server including the departments.   

Vba32 Control Center provides the solution of the issue – sending the specified events to 
Vba32 Control Center that is superior in the hierarchy. The only action you need to do if you 
want  to  manage  workstations  of  any  child  Vba32  Control  Center  is  to  access  its  web-
interface.

Any Vba32 Control Center can be a child one. To do so, you should enable periodic sending 
events to a parent Vba32 Control Center.

Configuring Child Vba32 Control Centers



Warning! This configuration can be made only when working under an account with administrative 
privileges.

To configure event sending, press the “Maintenance” link in the “Administration” menu.

Check the “Send events to parent Control Center periodically” flag to enable sending. You 
should specify the name or IP-address in the “Server” field, select periodicity of sending 
from the “Data sending interval” drop-down list.

Press the “Save” link to apply the settings.

Vba32 Control Center allows selecting types of the events that will be sent to a parent one. 
As a rule it’s reasonable to send critical events such as malware detection, etc.

Use the “Maintenance service settings” page to configure events that will be sent to the 
parent Vba32 Control Center.  The form “Events to send” displays a multipage list of the 
events registered in the system. Page browsing is standard: links > and < load the next and 
the previous page correspondingly, << and >> - the first and the last one.

The “Send” column, on the left of the event name, contains an option in a form of an icon 
whether the event will be sent to the parent Vba32 Control Center. If the icon is green the 
event won’t be removed from the database during the maintenance. To change the option, 
press the icon, and it will become red.

Changes will be applied immediately.

Configuring Parent Vba32 Control Center

No configuration should be made at the parent Vba32 Control Center.

Displaying Events from Child Vba32 Control Center

Events from a child Vba32 Control Center will be displayed in the common event list (the 
“Events” page). The “Computer name” field will contain the name of the child Vba32 Control 
Center that has registered the event. The “Object” field will contain the information on exact 
workstation from a domain where the event has occurred.

The child Vba32 Control Center will be registered in the computer list at the parent one. At 
that the “Control Center” field will be checked.
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